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February 2017 Update (Build 20.4.54)
This update fixes the following issue in the U.S. and Canadian editions:

n In the 9-5 Takeoffswindow, we fixed an error that could occur after you inserted new bid items or phases
while in a takeoff. The grid might not have displayed any details for existing items or phases that were
numbered greater than the number you inserted, and you received an error saying "Unable to complete
operation" when you tried to save the takeoff.

February 2017 Update (Build 20.4.54)
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February 2017 Update (Build 20.4.51)
This update fixes the following issue in the U.S. and Canadian editions:

n You no longer receive an error when you use the F7 key on items in the systemmenu.

February 2017 Update (Build 20.4.51)
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January 2017 Update (Build 20.4.49)
This section describes tax changes included in this January update. It also includes program fixes
implemented since the year-end update released in December 2016.

U.S. Payroll Tax Tables
Payroll tax tables have changed for the following jurisdictions:

l Colorado

l North Dakota

l Oregon

Fixes—Version 20.4 January 2017 Update
Wehave fixed the following issues in the January 2017 product update for Sage 100 Contractor Version 20.4:

n In the 9-5 Takeoffswindow, when you enter a value in thePart# field, and then open the associated lookup
window, the lookup list begins with the number you entered.

n 5-1-7 Union Reports now include calculations that use theCalculation Method 19 – Per Hour (worked
hours).

n You no longer receive a parameter count mismatch error when you edit job costs on posted transactions.

n User Defined fields can now use Date, Number, Yes/No, Phone#, File Name, as well as the Character
type.

n When computing payroll withWA workers compensation, you no longer receive an error message if the
amount of wages subject to workers compensation is less than the amount of employee deductions that are
not subject to workers compensation.

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

n On the 5-1-6-51 Certified Payroll Report for Alaska, the last page shows the correct address for
Region II.

Fixes for the Canadian Edition
The following issue was fixed specifically for the Canadian edition:

n On the Dashboard, theReceivable Holdback andPayable Holdback by Job panels display the correct
holdback amounts whenmultiple jobs are selected.

January 2017 Update (Build 20.4.49)
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U.S. Payroll Tax Tables—December 2016
Federal Payroll Tax Changes
There are two new Offer of Coverage codes for Form 1095-C for the 2016 reporting year:

l 1J: “Minimum essential coverage providingminimum value offered to you; minimum essential
coverage conditionally offered to your spouse; andminimum essential coverage NOT offered to your
dependent(s).”

l 1K: “Minimum essential coverage providingminimum value offered to you; minimum essential
coverage conditionally offered to your spouse; andminimum essential coverage offered to your
dependent(s).”

These changes are reflected in the 5-2-1 Employees window and on associated reports.

Note: Codes 1I and 2I for Form 1095-C are no longer applicable and have been reserved.

State and Other Government-Mandated Payroll Tax Changes
Payroll tax tables changed for the following jurisdictions for 2017:

l California

l Indiana

l Kentucky

l Maine

l Maryland

l Minnesota

l Missouri

l Nebraska

l New Mexico

l New York and Yonkers

l Oklahoma

l Rhode Island

l South Carolina

l Vermont

New Deadlines for Federal Tax Filing
Be aware that some federal tax filing deadlines have changed, so you will have less time to submit your 2016
forms.

U.S. Payroll Tax Tables—December 2016
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For a list of filing dates, see the Employment Tax Due Dates page on the IRS website.

If you efile through Aatrix, note that youmust submit your electronic file to Aatrix before the IRS due dates.
See the 2016 eFile Due Dates page on the Aatrix website for filing deadlines.

U.S. Payroll Tax Tables—December 2016
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Canadian Payroll Tax Tables—
December 2016
This section highlights federal, provincial, andQuebec tax changes.

For more information about these changes, and for information on Employment Insurance, see the Canada
Revenue Agency website.

Federal Payroll Tax Changes
Changes to Canadian payroll taxes include the following :

l Income tax thresholds and personal amounts are indexed for 2017.

l EI maximum annual insurable earnings and the EI premium rate changed.

l CPP maximum pensionable earnings and the basic exemption changed for 2017. Themaximum
contribution amount also changed.

l The Canada Employment credit amount changed for 2017.

Quebec Payroll Tax Changes
Changes to Quebec payroll taxes for 2017 include the following:

l TheQPP maximum contribution amount and contribution rate changed.

l TheQPIP maximum earnings and rate changed.

Other Provincial and Territorial Payroll Tax Changes
The following provinces and territories mandated payroll tax changes, effective January 1, 2017:

l Alberta

l British Columbia

l Manitoba

l New Brunswick

l Newfoundland and Labrador

l Northwest Territories

l Nunavut

l Ontario

l Prince Edward Island

l Quebec

Canadian Payroll Tax Tables—December 2016
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l Saskatchewan

l Yukon

For detailed information on personal amounts, see the TD1 form for each province or territory.

Canadian Payroll Tax Tables—December 2016
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Enhancements in version 20.4
This section describes the new features and enhancements you will find in version 20.4.

Migrate data from version 19.8
Wehave updated Database Administration tomigrate data from version 19.8.

Important! Youmust upgrade to version 19.8 before you canmigrate your data to Sage 100 Contractor
2016 (SQL).

Copy external files to other users
Because custom reports and custom forms are located in each user’s private User Data folder and not in a
database, you cannot use theCopy User Defaults feature in the 7-2-2 User List to copy a user's private
custom reports and forms to another user.

With version 20.4, Database Administration provides a way to copy these files to other users, as follows:

1. In Database Administration, click Toolbox > Copy User Files.

2. In theSelect user to copy file from box, select the user whose files you want to copy.

3. In theSelect type of files to copy box, select one of the following types of files:

l Private custom reports

l Private report forms

On the lower left side of the tab, a checklist appears, showing all the external files for the selected
user.

Another list shows all the Sage 100 Contractor users that have a personal User Data folder.

4. In theSelect files to copy box, select specific files to copy to other users.

5. In theCopy files to selected users box, select the users who need the copied files.

Tip: To select all the displayed files, click the first file in the list, press Shift+End, and then press
theSpacebar.

6. Click [Copy Files].

Note: If a file in the target folder has the same name as a file you are copying, youmust confirm
whether to overwrite the existing file or skip it.

New Option to Approve the Removal of Employee Records
In Database Administration, on theClose Company Payroll tab, when you choose to remove the employee
records of terminated employees, you can also select a new option to approve the removal of each terminated
employee record.

Enhancements in version 20.4
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If you select this option, when Sage 100 Contractor attempts to delete employee records after archiving the
payroll, you are prompted to confirm the removal of each employee.

If an employee record is used elsewhere in the database, Sage 100 Contractor does not delete the record. At
the end of the process, it displays a list of terminated employees whose records were not deleted .

l You can copy and paste the list into Notepad or another text editor to save it for reference. Press
Ctrl+A to select all the text in themessage window, press Ctrl+C to copy it, and then press Ctrl+V to
paste it in a document in your text editor.

l To find out why an employee record was not removed, you can attempt to delete the record in the 5-2-1
Employeeswindow. When Sage 100 Contractor cannot delete the record, it displays the Delete
Record Conflict window that lists the records that the employee record. You can click an item on the
list to drill down for further information about the conflict.

New Live Chat button for contacting Support
Look for the new [Live Chat] button located in the lower left-hand corner of the Sage 100 Contractor desktop,
where it is easily accessible.

Enhancements for the U.S. Edition

New ACA Offer of Coverage codes
In the 5-2-1 Employeeswindow, the ACA tab includes two new Offer of Coverage codes for the 2016
reporting year and subsequent years. The new codes, 1J and 1K, are used on IRS Form 1095-C.

Codes 1I and 2I are available only for the 2015 reporting years, and earlier.

A New Pay Statement for Employees
In the 5-2-7 Compensation Slipswindow, you can print a new report, 41-Pay Statement, that provides
additional information (such as details about timecards) that employers in Oregon are required to provide to
employees beginning in 2017.

In addition, the 5-2-1 Employeeswindow includes a new Pay Classification box where you can enter a pay
classification for inclusion on an employee's 5-2-7-41 Pay Statement report.

Note: If you are not required to submit 5-2-7-41 Pay Statement reports, you do not need to enter anything
in thePay Classification box.

Enhancements in version 20.4
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Fixes in Version 20.4
Fixes in the U.S. and Canadian Editions
Version 20.4 includes the following software fixes in both editions:

n Wehave removed the restriction that prevented you from installing the software on a domain controller.

Note: Although we have removed this restriction, we recommend that you do not install the software
on a domain controller. For more information, see Knowledgebase article ID 79778.

n When a new user in a workgroup environment signs in to Sage 100 Contractor for the first time, if the
program cannot create their user folder with restricted access, it creates the folder with unrestricted
access.
To find out what to do if a user has received a connection error when first signing into Sage 100 Contractor
in a workgroup environment, see Knowledgebase article KB70761..

n When you drill down onOther Accounts from the Dashboard, the amount reported for Other Accounts
agrees with the individual amounts that are listed for the accounts in the Dashboard panel.

n When you use the F9 key in a date field, the first record for the date appears. You no longer receive an error
message.

n We fixed an issue that occurred in some environments that caused Notes to load very slowly. Notes now
appear promptly when you open a Notes window.

n When you create a company based on an existing company, the numbering of journal entries, invoices, job
costs and other entries in the new company starts at record 1.

n You do not need to be a company administrator to generate scheduled reports.

n You can open the 3-3-1 Cash Receiptswindow from theClients and Services tab by by clicking
Receipts > Cash Receipts.

n When you set an Invoice Over PurchaseOrder warning in the 4-2 Payable Invoices/Creditswindow, you
can no longer save a new invoice that will exceed the limit set for purchase order.

n When you void a two-party check, the payment to the secondary payee is properly removed from the
Secondary Payees window.

n The Year EndGuide link in the now-obsolete 5-3-8 Close Payroll Yearwindow correctly points to the Year
EndGuide for version 20.4.

n The Year EndGuide link on theArchive Payroll Data tab in Database Administration correctly points to
the Year EndGuide for version 20.4

n When using the API to add or modify a 5-5 Daily Payroll record, when you submit an entry with Pay Type 9
- Misc. Pay, you receive an error message if the entry includes hours.

n You require the Inventory module to save a purchase order receipt in the 12-4 Purchase Order Receipts
window.

n When you export to a ServiceWork Order in the 9-5 Takeoffswindow, assembly arrows now appear
correctly for the takeoff in the Invoice Details grid in the to the 11-2 Work Orders/Invoices/Credits
window.

Fixes in Version 20.4
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n In the 11-2 Work Orders/Invoices/Creditswindow, you no longer receive an error if you scroll through the
grid when rows are hidden.

n In the 11-2 Work Orders/Invoices/Creditswindow, rows that you hide in a displayed record remain
hidden when you resize the window.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n In the 3-5 Jobswindow, in theContract Summary, we changed theEarned to date label to read Invoiced
to date. We also added three new columns to the grid in the Invoiceswindow. Subtotal, Holdback, and
Sales Tax appear before the Invoice Total column. The total of the Invoice total column now matches the
Invoiced to date amount in the Contract Summary. The order of the columns matching the sequence of
arithmetic operations makes these amounts easier to reconcile (Total - Holdback = Invoice Amount.
Invoice Amount + Sales Tax = Invoice Total.)

n In the 3-2 Receivables Invoices/Creditswindow, you no longer receive an error message when you save
an invoice with a holdback.

Fixes in Version 20.4
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Upgrading from version 19.8?
New Microsoft SQL Server Platform
Although Sage 100 Contractor 2016 has the same look, feel, and functionality that you are familiar with, its
new SQL database structure affords much tighter security and an up-to-date technology on which to build
future releases. It also provides several other notable enhancements, including:

l A new, separate Database Administration tool. You don't have to be an expert user of Microsoft
SQL Server to take advantage of its robust features! We designed Database Administration to
optimize your data for Sage 100 Contractor, for example, by keeping related data in expected locations
and creating backups automatically before performing certain critical processes. Many of its features
are not available through SQL Server Management Studio.

Significantly, Database Administration includes amigration utility that we have designed and tested
extensively to help ensure a smooth and painless transition to SQL Server.

We have relocatedmany administrative utilities and functions from themain Sage 100 Contractor
program to this new tool. However, we have boosted their capabilities considerably, and now provide
easily scheduledmaintenance and backup functions to help you to keep your Sage 100 Contractor
companies in good order.

In addition, Database Administration offers several powerful, new capabilities that enable you to
maintain tight security and exert fine control over user and program access to your SQL Server
instance.

For a comprehensive list of the utilities you will find in Database Administration, see “Database
Administration for Sage 100 Contractor”, later in this document.

Note: Database Administration comes with its own help system and a new Database and
Company Administration Guide to acquaint you with its features and to guide you in its use.

l New views for creating reports with third-party report writers. Because the new views point to
the database tables, rather than pointing your reports directly to the tables, we encourage you to use
them when creating custom reports using third-party tools, such as Crystal Reports.

For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts
Payable vendor names in custom reports. In the version 20.4 company database, this information
resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table
name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in
the Views folder in your company database.

Upgrading from version 19.8?
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Tip: A compelling reason to use these views is that they may not be affected by many types of changes
to the underlying tables, so future database changes will not necessarily "break" your custom reports.

Software and hardware required to support Microsoft SQL Server
Version 20.4 requires an instance of Microsoft SQL Server. You can download and useMicrosoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configureMicrosoft SQL Express for you.

Refer to Knowledgebase article 79790 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Database Administration for Sage 100 Contractor
The new Database Administration tool is intended for designated system administrators and company
administrators. You use it to set up andmaintain your company databases, and to select advanced settings to
manage communications with and access to your Microsoft SQL Server instance from other programs.

If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For
example, Database Administration includes utilities for creating and deleting a company, backing up and
restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.

Upgrading from version 19.8?
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Important! Wehighly recommend that you use Database Administration, rather than SQLManagement
Studio®, to perform the database administration tasks listed below, even if you are an experienced SQL
Server user. Besides handling all the database tasks that you are likely to perform in a typical Sage 100
Contractor system, Database Administration was designed to optimize your data for Sage 100
Contractor, for example, by keeping related data in expected locations and creating backups
automatically before performing certain critical processes. In the rare event that you need to use SQL
Management Studio® to perform a task that is not provided in Database Administration, you should
contact Customer Support for assistance.

Database Administration includes the following database and company management utilities:

l Create Company Based on Existing andCreate Company create new Microsoft SQL Server
databases.

l Rename Company andDelete Company are convenient utilities when working with existing
companies.

l Deploy Sample Company helps you install and refresh the sample data that comes with Sage 100
Contractor.

l Tune Up Company Databases performs various maintenance tasks to keep your database
functioning efficiently.

l Back Up Company Databases enables you to back up your data "on demand," whenever needed.

l Restore Company from Backup restores a backed-up copy of your database.

l Upgrade Company Databases prepares your SQL company data so that it is compatible with the
most recent version of Sage 100 Contractor 2016.

l Migrate Company Data andMigrate Custom Reports transfers your version 19.8 company data and
custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared folders
under \\ServerName\CompanyName, organized using a folder structure similar to earlier versions.

l Schedule Nightly Maintenance utilities enable you to schedule backup andmaintenance operations
for times when other users are not logged into the system. You can also select the number of
consecutive backups to keep.

l Manage Company Admins/SQL Logins utilities enable you to set up or delete logins to the SQL
Server database, and to designate a user as a company administrator for a specified Sage 100
Contractor company.

l Advanced Company Settings lets you specify how long to keep history about database changes for
each company, including details about changed records, such as the date and user ID of the employee
made the change. Details older than the retention period you specify are cleared during nightly
maintenance. (This history is maintained in separate audit tables, which you can query using SQL
Server Management Studio.)

l Advanced SQL Server Settings includes convenient, sophisticated access andmemory
management controls for your SQL database.

l Advanced Backup Settings lets you specify a backup folder if you prefer not to use the default folder.
You can also specify the number of days to keep "on demand" backup files.

For detailed information about these utilities and how to use them, see the Database Administration help or
refer to the new Database and Company Administration Guide.

Upgrading from version 19.8?
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Additional Changes for SQL Server
In addition to the new SQL database platform and the Database Administration tool, you should note the
following important differences from earlier versions:

l Because each user must now identify themselves to SQL Server using a unique SQL login, there is no
longer a single Supervisor user. Instead, you designate as Company Administrators users who require
elevated privileges in Sage 100 Contractor.

Tip: You can copy supervisor preferences used in version 19.8 to individual users in the version
20.4 User List window.

l When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new Connect
to SQL Serverwindow, and then you select your company and type of access from theCompany
Listwindow.

If you need to change the type of access after logging into the company, you can return to the
Company Listwindow using theChange Company/Access link on the Sage 100 Contractor
desktop.

Note: If you want to log in as a different user, youmust close Sage 100 Contractor completely
first, and then log in using a different user name.

l You no longer need to reindex your data after upgrading. Now, you use the Database Administration
tool migrate your data from version 19.8 and to update it in future.

l Version 20.4 and subsequent releases are installed to a different location than version 19.8 and earlier
versions.

Having separate installation locations enables you to run version 20.4 and version 19.8 on the same
computer while youmigrate your data to the new version.

l You need to install the License Administration application and activate the software on the same
computer as your version 19.8 license server, choosing the option to use the computer as the license
server for version 20.4. After installing Sage 100 Contractor on other networked workstations, point to
this machine as the license server.

For more information, see the Installation and License Administration Guide.

Notice about Supported Windows Operating Systems
Sage 100 Contractor 2016 supports Windows Server 2008 R2, and later versions of Windows. However, it
does not support Windows Server 2008 and Small Business Server 2008 because they do not support .NET
4.6.1, which this version of Sage 100 Contractor requires.

For current information about supported operating systems, Internet browsers, and other software, and about
system requirements for servers and client workstations, refer to our Knowledgebase article ID 79790,
available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=79790.

Upgrading from version 19.8?
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Installing Sage 100 Contractor 2016
Installation of Sage 100 Contractor 2016 and upgrading your data involves a few more steps than in previous
editions because you need to install two additional components. You need to:

l Install the Database Administration tool on themachine you will use as your server.

l Create a SQL Server instance for Sage 100 Contractor. This process is simplified if you use the option
to downloadMicrosoft SQL Server and create an instance automatically when you first open

For detailed instructions on installing Sage 100 Contractor 2016, see "Chapter 3: Sage 100 Contractor
Installation," in:

l The Sage 100 Contractor Installation and License Administration Guide (U.S. Edition)

l The Sage 100 Contractor Installation and License Administration Guide (Canadian Edition)

Printable checklists help you get started
Two printable checklists are available to help you get started using Sage 100 Contractor 2016. Download
them from our website, print them, and then check off each step on the printed list as you complete the
necessary tasks.

l Use theQuick Start Checklist to help you stay on track when you set up your company or migrate your
company from version 19.8. It provides an overview of all the important steps you should complete to
install version 20.4

l Use the "Going Live" Checklist when you are ready to start using Sage 100 Contractor 2016 in a
production environment (rather than a test environment). It lists all the important steps you should
complete to "go live" with Sage 100 Contractor 2016.

Other Enhancements Introduced in Sage 100 Contractor 2016
(SQL)

More versatile Lookup windows
Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows throughout the
program

Using the new Lookup windows, you can view information and select records in convenient new ways,
including:

l Choose columns to display or hide in a Lookup window.

On theOptionsmenu in any Lookup window, click Select Columns to Show, then select the check
boxes for each column you want to display in the Lookup window, or clear the check box to hide a
column from view.

l View the names associated with columns that display certain numbered records, for example, the
vendor names for vendor numbers, job names for job numbers, account names for account numbers,

Upgrading from version 19.8?
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and so on.

Sage 100 Contractor displays name columns automatically for these numbered records, identifying
them by enclosing the column heading in parentheses, for example "(Vendor Name)."

Note: You cannot hide these name columns while the associated number column is displayed,
although you canminimize the columnwidth by dragging the right edge of the column header. If
you hide a number column, the associated name column is also hidden.

l Change the order in which columns appear in a Lookup window.

Simply grab the column heading for a column you want to move, then drag it left or right until it is
positioned where you want it to be.

Note: If you separate a name column from its associated number column, the Lookup window
does not retain the new position the next time you open the Lookup window. The name column
always appears beside its associated number columnwhen you open any Lookup window.

l View more accurate results, and find records more quickly, when you begin typing a search term in a
data control box.

The new Lookup windows display only the records that begin with the characters you type, filtering
evenmore effectively as you continue typing.

When you see the record you want, select it on the list, and then press [Enter] to use it in the
transaction or other window you were working with.

When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns
appear as you want them the next time you use Lookup features in that window.

Simplified schedules lookup
In the 10-3 Scheduleswindow, you can use a new Schedules button on the toolbar to look up jobs and
phases that are associated with a schedule.

When you select a job and phase in the Lookup window, the associated schedule appears in the grid in the 10-
3 Scheduleswindow.

Unique Payroll record numbers
After you archive payroll, payroll numbers continue in sequence, rather than starting from 1, as in previous
versions. The advantage is that payroll record numbers are now unique for a company, even across years.

Upgrading from version 19.8?
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View Change History in Records
Many data entry windows in version 20.4 include a new View menu, with options that enable company
administrators to view the history of changes to a selected record.

This capability can be helpful when you need to determine the source or the timing of a change in a record.

Notes:
l The depth of the change history is determined by the retention policy set for your company in
Database Administration. History is retained for 180 days by default, but you can change the
retention period.

l You do not have to log into the company with Administrator rights to view history, providing you are
set up as a company administrator in the 7-7-2 User List.

When you display a record in a window that has a View menu, you can select one of two options to view
history:

l View > Record history.When you select this option, a separateView Historywindow opens,
displaying a list of all the changes to the current record.

Initially, the list summarizes all the changes to the record, showing for each change

l The database table that was updated,

l Whether new information was inserted or existing information was modified or deleted.

l The date and time.

l The login ID of the user whomade the change.

l The ID of the computer where the change originated.

l The application where the change originated (for example, Sage 100 Contractor, Database
Administration, or SQL Server Management Studio).

Tip: If there weremany changes, you can filter a long list to show only changes for a particular
table, user, or application.

To view the details of a particular change, click the row on which the change is listed. Sage 100
Contractor displays aHistory Detailswindow that shows, for each field in the record, the value of
each field before and after the change.

l View > Field history.When you select this option, field entries that have changed for the current
record are displayed against a yellow background.

To view change details for a particular field, click the field, and then press [F12]. Sage 100 Contractor
displays a separateHistorywindow for the field that lists the ID of each person whomade a change,
the date of the change, the field values before and after the change, and the application where the
change originated.

Note: With View Field History turned on, you cannot edit the record.

Upgrading from version 19.8?
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The view history options are turned off when you close the window ormove to another record.

Note: Although the following windows include a View menu, some special conditions apply:

l In 5-2-1 Employees, history is not provided for theACA tab.

l In 5-2-2 Payroll Records, history is not provided for the theCalculations tab.

Option for closing purchase orders automatically
In earlier versions, if you were a company administrator, you could select an option to close purchase orders
automatically. Sage 100 Contractor assigned the 4-Closed status to a purchase order when you posted a
receipt in the 4-2 Payable Invoices/Credits or 12-4 Purchase Order Receiptswindow that produced a zero
or negative balance on the purchase order.

As of version 20.3, the Options menu in the 6-6-1 Purchase Orderswindow provides a new option for closing
purchase orders automatically when you post a receipt that reduces all quantities to zero.

To have Sage 100 Contractor close purchase orders automatically:

1. In the 6--6-1 Purchase Orderswindow, click Options > Automatic Close.

2. On the Automatic Closemenu, select one or both of the following options:

l When Balance Is Zero or Negative. (This option was available in previous versions.)

l When All Quantities Equal Zero. (That is, the purchase order is closed when the sum of the
To Date andCanceled columns equal the sum of theQuantity column. If any quantity remains,
positive or negative, the purchase order remains open.).

Note: TheAutomatic Close option is available only if you are a company administrator.

Support for Sage Exchange Desktop 2.0
In version 20.3, we upgraded Sage 100 Contractor to the latest Sage Payment Solutions technology, which
supports chip card-readers and EMV processing.

Support for Customized Tables and Views
Administrators and third-party developers can now add customized tables and views to Sage 100 Contractor
databases. Sage 100 Contractor reserves a special namespace designation for customizations, preventing
potential conflicts with future software development, or the creation of incompatible customizations.

Before you can add tables and views, youmust create a schemawith a name that begins with dbx_ to identify
it as a custom schema. Dbx_ should be followed by your company name or another unique label that will
distinguish it from other third-party schemas. For example, Rupert Everett Consulting could create a schema
called dbx_REVERETT.

You can then add tables and views to this schema, and you can addmultiple schemas, as needed.
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New window to add client service locations quickly
In the 11-2 Work Orders/Invoices/Creditswindow, you can use a new Add Service Locationwindow to
add a new location. If you have a large number of locations for a client, using this new window to add a
location can bemuch faster than the location grid.

A new Create New Locations with Quick Add option is available from theOptionsmenu. If you select this
option, when you type a new code in the Location field, press Enter, and then choose to add a new location
record, theAdd Service Locationwindow appears instead of the location grid.

Whether or not you select the new option from theOptions menu, you can open theAdd Service
Locationwindow by first opening the Location lookup window, and then clicking either theQuick Add button
or theOptions > Quick Addmenu selection.

Note: Youmust enter a client in the 11-2 Work Orders/Invoices/Creditswindow before you can add a
new service location for the client.

Saving the location record adds it automatically to the Location lookup window.

Enhancements for the U.S. Edition
n The Illinois Certified Report now breaks out prevailing and non-prevailing wage hours.

n TheSales Tax Districtswindow now includes a column to show the effective tax rate for each tax district.
You can also add this column to the Tax Districts lookup window using theOptions > Select Columns to
Show option in the lookup window.

Notes for Third-Party Developers
API Enhancements

The API supports adding and removing attachments on all Sage 100 Contractor forms that support
attachments and have API support forAdd,Modify, andDelete.

As with the existing API forWork Orders, these changes do not include support for:

l Changing the description on attachments

l Web links

Other API enhancements include:

n The API now includes the JobCostQrymethod to query the Job Cost table.

n The API now provides three new methods to determine whether a Sage 100 Contractor database has been
opened exclusively, to set exclusive access, and to release a database from exclulsive access.

Thesemethods are:

p GetCompanyAvailability

p GetExclusiveAccess

p ReleaseExclusiveAccess

Upgrading from version 19.8?

Release Notes 20



Note: If you submit a request for exclusive access to a company using the same instance of the API
that already has exclusive access to another company, you will lose exclusive access to the other
company.

n You now receive an error if you try to insert or delete certain types of records, where a certain number of
records is required for the program to function properly.

Because exactly one Company Information recordmust exist for a company, you cannot addmore than
one company, and you cannot delete the Company Information record.

Because theremust be exactly nine cost types, you cannot add or delete Cost Type records.

Because theremust be exactly one database properties record, you cannot add or delete Database
Properties.

Because there can be only zero or one Ledger Setup record, you cannot delete the Ledger Setup record if
ledger transactions exist.

Schema Change for Global Variables

The API schema required a change for the TakeoffGlobalVariable object. Third-party applications that add,
modify, or delete TakeoffGlobalVariables objects must update formats as follows:.

l ObjectRef is no longer associated with theVariableName element. It is now associated with a new
LineID element.

l TheDesc element now appears beforeVariableName.

Migrating your company data from version 19.8
Important! Youmust be using Sage 100 Contractor version 19.8 tomigrate your company to version
20.4. If you are using an earlier version of Sage 100 Contractor, youmust first upgrade your company data
to version 19.8.

You use themigration utility in the new Database Administration tool to automatically migrate and upgrade
your data to version 20.4, including all company data in folders and subfolders of…\MB7\[CompanyName].

Migrated files are located in shared folders under \\ServerName\CompanyName. These subfolders are
organized using a similar folder structure as in earlier versions, and include:

l Aatrix Forms

l Attachments

l Direct Deposit

l Images

l Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100
Contractor. The remaining folders are created as needed.
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Note: For detailed, step-by-step instructions onmigration, see the Database and Company
Administration Guide or the Database Administration help.

Preparing for migration in version 19.8
Migration should proceed smoothly in most cases. However, you should audit your accounting data and your
company payroll in version 19.8, and then fix any errors, before attemptingmigration to version 20.4.

Use the following audit tools to prepare your data in version 19.8:

l 1-6 Period and Fiscal Year Management > Audit Books

l 5-3-7 Payroll Audit

l 6-6-3 PurchaseOrder Audit

l 6-7-4 Subcontract Audit

l 12-5 Inventory Audit

Note: If your data includes serious audit errors, youmay need assistance from your business partner or
consultant to prepare your database for migration.

Migrating reports
The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor
reports and reports written with the Sage 100 Contractor report designer.

In version 20.4, shared custom reports and form designs are located in these folders:

l \\ServerName\Sage100Contractor\Custom Reports

l \\ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated
with each user name, as follows:

l \\ServerName\Sage100Contractor\User Data\username\Custom Reports

l \\ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports
You also need to update custom reports created with third-party software, such as Crystal Reports, so they
map to the new database.

We recommend that you use the new report views that comewith version 20.4 to create or update reports.
The new views were created for your convenience, so that future database changes will not necessarily break
your custom reports.
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After migrating your company data
After migrating your data, you will likely need to perform the following additional steps to prepare your
company for use in Sage 100 Contractor:

Important! UseDatabase Administration, not SQL Server Management Studio, for all these tasks.

l Add company administrators. There is no longer a generic "supervisor" user as there was in earlier
versions. All users must sign into the company using their personal IDs, and only users designated as
company administrators have heightened privileges previously associated with the "supervisor" role.
You can designate one user as a company administrator duringmigration, but you can add others later.

l Add SQL logins for new users. If you have new users that did not exist in your version 19.8
company, add them as users to the SQL database.

Youmust also add them as users and assign security in Sage 100 Contractor.

l Designate an additional SQL Server administrator. Only a user with system administrator
privileges for the SQL instance can administer users for SQL Server or assign the system
administrator role to another user. Therefore, it is vital at all times that more than one user has a
system administrator role. If the principal system administrator should suddenly fall ill, or leave your
company, or otherwise be unable to perform their duties, another person with administrative access to
the SQL Server databasemust be able to take over that role.

Note: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role in
SQL Server. When they designate a SQL Server administrator in Database Administration, that
person is also assigned the 'sysadmin' role in SQL Server.

l Switch your Sage Construction Anywhere to version 20.4. If you have been using Sage
Construction Anywhere with Sage 100 Contractor version 19.8 and want to use it with version 20.4,
you will need to switch the connection to version 20.4. For help on switching the connection, see the
instructions in the Installation and License Administration Guide.

l Migrate your Sage ACT! settings to version 20.4. If you have been using Sage ACT! with Sage 100
Contractor version 19.8 and want to use it with version 20.4, you need to change your ACT! settings to
point to your new version 20.4 company database. For help onmigrating your ACT! settings to version
20.4, see the instructions in the Installation and License Administration Guide.

l Migrate each user's scheduled reports from version 19.8. See the instructions in the Installation
and License Administration Guide.

l Migrate each user's alerts from version 19.8. See the instructions in the Installation and License
Administration Guide.

Changes to converted data
Duringmigration, the programmay encounter problems that might prevent it from writing a particular record to
the new SQLServer database.

If the problem is one that themigration program can fix, it repairs the record, and then writes the updated
record to the SQL Server database. (For a list of the types of errors that can be fixed duringmigration, see the
Database and Company Administration Guide.)
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Note: Not all errors can be fixed duringmigration. In these cases, the record is not written to the new
database.

The migration log file

The program keeps a log of all changed records and records that were not migrated because of an
unresolvable error, unless the record was invalid in version 19.8. (Invalid records are neither migrated nor
logged.)

After migration, you should check the log file to see what changes weremade to your data during conversion,
or whether any records were not migrated to the new SQL database.

The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example,
C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more
detailed information about each error found.

Using Sage 100 Contractor Intelligence Reporting with Sage 100
Contractor 2016
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.4.
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 20.4.

General

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests,
accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is
installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for
each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the
Internet.

Note: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and
other system requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some
other firewall, however, youmay need tomanually adjust some settings in the firewall in order to ensure
proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually
configuring other third-party firewall products.

To configure the Windows Firewall:

1. ForWindows Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security.

ForWindows 8.1 andWindows 10, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected..

Note: By default, the exception is set to allow access by any computer on the network. You can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can
cause the computer to be unable to connect with some or all of the other machines on the network.
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Files to exclude when manually configuring your firewall for Windows 8.1 Professional
32-bit

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional
64-bit

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor
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l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows Server 2008 R2,
2011, 2012

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL Server
Version 20.4 requires an instance of Microsoft SQL Server. You can download and useMicrosoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configureMicrosoft SQL Express for you.

Refer to Knowledgebase article 79790 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is not
supported
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL
Server on a read-only domain controller should you encounter any problems with this configuration.

Because youmust install Database Administration on the samemachine as SQL Server, you should not
install Database Administration on a domain controller. To guard against inadvertent installation on a domain
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controller and the potential for irrecoverable data losses, you will receive an error message if you attempt to
install Database Administration on amachine used as a domain controller .

For more information, see theMicrosoft Knowledgebase article https://support.microsoft.com/en-
us/kb/2032911.

About .NET Framework
.NET 4.6.1 Framework is required

If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install
Sage 100 Contractor. Installation of .NET 4.6.1 Framework alonemay take up to 20minutes per computer.

Make sure that both your client and server computers meet theminimum requirements for installing both Sage
100 Contractor software and .NET 4.6.1 Framework.

Note: If Sage 100 Contractor requires an installation of .NET 4.6.1 Framework, the Sage 100 Contractor
installation process may continue automatically after the .NET Framework installation is completed. If
you are prompted to restart your computer after the .NET Framework installation, youmust do so to
continue the Sage 100 Contractor installation.

.NET 3.5 is also required

In some situations, youmay need to turn on .NET 3.5manually by selecting the .NET 3.5 check box in the
Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.

Windows Small Business Server 2011 is not supported

Microsoft Small Business Server 2011 does not support .NET Framework 4.6.7, which Sage 100 Contractor
(SQL) requires. Unfortunately, this means that Sage 100 Contractor (SQL) cannot support Small Business
Server 2011.

Turning on Microsoft .NET 3.5

Microsoft .NET 3.5must be available and enabled prior to installing Sage 100 Contractor on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5 loaded but not installed, so Sage 100
Contractor does not install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5 installed, you receive the followingmessage
during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you
click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot
open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5 has been installed. If you
receive the abovemessage during installation, install .NET Framework 3.5., and then reinstall Sage 100
Contractor.

The following instructions are forWindows Server 2008 R2.
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To verify that .NET 3.5 is installed on Windows Server 2008 R2:

1. Click theStart button in the lower left corner of the display.

2. Highlight Administrative Tools and select Server Manager.

3. In theServer Manager interface, click Features to display all the installed Features in the right-hand
pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5 on Windows Server 2008 R2:

1. In theServer Manager interface, select Add Features to display a list of possible features.

2. In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box
next to .NET Framework 3.5.1 and click Next.

4. In theConfirm Installation Selections interface, review the selections and then click [Install].

5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1may require a reboot.

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port
48750. Certain configurations can potentially disable the communication:

l Youmust enable file sharing on your computers. To enable file sharing, follow the instructions in the
Windows Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on
the local computer.

l Software firewalls running on the local computer can be configured to block processes from opening
TCP ports, which will prevent communication through the TCP Remoting Channel.

Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for
Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage
100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

Tip: Use theCustomize settings in theWindows system tray tomake sure you can view the Sage
Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see "About Sage Advisor Update" in the User Guide and in
the Sage 100 Contractor help.
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PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit
card companies as a guideline to help organizations that process card payments to prevent credit card fraud,
cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card datamust be PCI-compliant or risk losing its
ability to process credit card payments and being audited and/or fined. (For more information about PCI
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable
merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The
payment processing program uses Sage Exchange, a secure payment-processing application, to connect to
Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and
credit card transactions without storing your customers’ sensitive card information in your database. Sage
Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions,
where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties
and credit card fraud.

Caution! To avoid non-compliance with PCI standards, do not store credit card information in Sage 100
Contractor. Such storage creates unnecessary risk for your business and your customers.

Using Sage 100 Contractor Intelligence Reporting with Sage 100
Contractor 2016
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.4.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

l For updating forms and executable files.

l For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an
Internet firewall. Firewalls need to have access allowed through specific ports:

l The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site
http://updates.aatrix.com.

l The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter
and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following
programs to access the Internet.
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For updating using http on port 80 to http://updates.aatrix.com:

l aatrixforms.exe

l updater.exe

l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

l builder.exe

l viewer.exe

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then
you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the
amount paid in the future period is allocated to the Current period or an aging period, depending on the due date
of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of
reports that reflect the true amount of retainage outstanding at year end.

Tip: If you archive your data at year end, you can also print the reports from the archive company, later.

Printing reports to PDF or exporting to Excel?
When you print reports to PDF, youmay find that the size of the PDF file is unexpectedly large and the
resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in
Compatibility Mode (compatible withWindows 7), and then print the report.

Note: You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if
you useMicrosoft Office 2013.

We have not encountered this issue during testing, nor has it been reported forWindows Server 2012 R2.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100
Contractor.

Important! To fax from Sage 100 Contractor, theWindows Fax Service component must be installed
with yourWindows operating system. For more information about installing theWindows Fax Service
component, see the Sage 100 Contractor Help topic, “Installing theWindows Fax Service component.”
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Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1, Windows 7 Professional, Server 2008, or Server
2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating
systems. If the service stops, the program displays amessage advising you to take further action to resolve
this issue.

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:

1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select the format for your country.

4. UnderDate and time formats, from the Short date format drop-down list, select the format used for
your country.

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Posting Status for a Company Created since Version 19.2
If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise
after you advance the year to the first period of the new fiscal year. The new year may not be available when
you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered
this issue, contact Customer Support for assistance.

Windows "Sleep Mode" prevents computers from obtaining a license use
If the computer you are using as a license server goes into sleepmode, other computers on the network
cannot obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. InWindows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control
Panel > System and Security > Power Options.

InWindows 7, click Start > Control Panel > System and Security > Power Options

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Known Issues and Comments

Release Notes 32



Windows 8.1 Professional and Server 2012 Standard
Operating Systems

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1 Professional orWindows 8.1 Enterprise operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2012 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Server
2012 Help.

Windows 7 Professional and Server 2008 R2 Standard
Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling
reports

Important! On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling
Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as
administrator.”

Microsoft Windows changed security rules in theWindows 7 Professional and Server 2008 R2 Standard
operating systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical
user, then you have limited privileges in some areas of the program, such as saving a report schedule. To
save a report schedule, youmust launch Sage 100 Contractor with the command to eitherRun as
administrator orRun this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100
Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from
this computer. Your settings on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session only. When you select Run
this program as an administrator, you set program properties to always run the program as administrator
when you log on to this computer.

Note: "Run as administrator" and "Run this program as an administrator" are not related to
Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a
specific program you are running.
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To set "Run as administrator":

1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, to launch the program, click Run as administrator.

Note: SelectingRun as administrator only runs the current session of running Sage 100 Contractor.
The setting does not persist after the session is over.

To set "Run this program as an administrator":

1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, click Properties.

3. On the Sage 100 Contractor Properties window, click theCompatibility tab.

4. Under Privileges Level, select Run this program as an administrator.

5. Click [Apply], and then click [OK].

Note: SelectingRun this program as an administrator always runs the program with these properties
when you launch the program on this computer. The setting persists.

Solution for Windows Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 R2 operating system, follow these instructions:

1. On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2. On the left side of the window, underComputer > Local Disk, right-click the \Sage100Con folder, and
then select Properties.

3. On theSage100Con Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, and then click theEdit button.

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.

Selecting Full control selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK].

7. On theSage100Con Propertieswindow, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay see the following error
message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."
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This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not
yet enabled the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message,
install Desktop Experience using the Server Manager utility:

1. InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server
Manager.

2. In theServer Managerwindow, click Features (left-hand pane).

3. In the Features pane, click Add Features.

4. Select the Desktop Experience check box.

5. If you are prompted to add additional features, click [Add Required Features].

6. Click [Next].

7. Click [Install].
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